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HELLO!

I'm here to talk to you about
something that took me a while to

around...
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But spending the last 18 months
working on a
website forced me to finally get it...
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b We are IN CONTROL of how

Google crawls and indexes
our website




I We are IN CONTROL of how Google crawls
and indexes our website

(but it can feel scary!)




Because if we don’t do it properly,
then we won't benefit from many
things we're doing right
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So if we're recommending SEO fixes
(small or large), let’'s please
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And focus on prioritising recommendations
that will

MozCon . :
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Setting the Scene
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» Our users can...

for cars near their
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» Our users can...

for cars near their

the search results by make,
model, year, type, transmission,
engine size, colour, price range (and
more!)
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» Our users can...

for cars near their
the search results by make, model, year, type,
transmission, engine size, colour, price range (and
more!)

» View and contact sellers
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» Our users can...

for cars near their
the search results by make, model, year, type,
transmission, engine size, colour, price range (and
more!)
> View and contact sellers

» View
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» Our users can...

for cars near their
the search results by make, model, year, type,
transmission, engine size, colour, price range (and
more!)
> View and contact sellers
» View

» Read the latest car
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» Our users can...

N4 MozCon
Virtual @areej_abuali
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Most webmasters tend to set up
websites in one of

IV Mozton @areej_abuali



P They either attempt to...

to capture as much
ranking opportunity as possible

MVA Mozton @areej_abuali
18



P They either attempt to...

to capture as much
ranking opportunity as possible

to avoid
suffering from index bloat
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IS when a site has an
excessive number of low-value

pages indexed
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P If we attempt to index everything...

We might end up indexing:

> geo-location
> filter combination
> car listing page
> car history information page
MVA Mozton @areej_abuali
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Why is this a
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P Will Google bother 72

> geo-location
> filter combination
> car listing page
> car history information page
MVA Mozton @areej_abuali
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P Will Google bother L7

> geo-location
> filter combination
> car listing page
> car history information page
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» Do you even for...?

> geo-location
> filter combination
> car listing page
> car history information page
MVA Mozton @areej_abuali
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The answer to all three questions Is
most probably:
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P If we attempt to

1. Google might not all our pages
2. (Google might not all our pages
3. Our might not be crawlead

and/or indexed
4. Qur valuable pages might not

MVA Mozton @areej_abuali
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I'm being generous by using the word

M MozCon
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P They either attempt to...

to-capture-as+uch
¥ i "

to avoid
suffering from index bloat
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P If we a huge chunk...

We'd miss out on for:
> geo-location
> filter combination
> car listing page
> car history information page
MVA Mozton @areej_abuali
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P They either attempt to...
to-capture-as+uch
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Before we make any decision on how
to control our indexability, we need
to know the answer to
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What's the that we're
being measured against?
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It probably isn't...

1. Organic rank

MV MozCon @areej_abuali
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P It probably isn't...

1. Organic rank
2. Organic sessions
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P It probably isn't...

1. Organic rank
2. Organic sessions
3. Some third party tool’'s visibility chart...
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It probably isn't...
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It's most likely
organic leads

or revenue
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An organic lead on
our car aggregator site
happens when a user
contacts a seller for a
potential car

Virtual @areej_abuali



So, why don't we
?

Indexed Pages Organic Leads
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P Let’s go back to this list...

for cars near their

the search results by make, model, year, type,
transmission, engine size, colour, price range (and
more!)
> View and contact sellers
» View
» Read the latest car

Virtual
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| tend to understand things better when
they're in , SO...
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Core Templates Description

Result pages when a user searches

Car search pages (CSP) for cars by location (includes all
search filters)

Listing pages when a user chooses
a car to learn more about it

Car listing pages (CLP)

Information pages that include car
valuation and history

Car history pages (CHP)

All other pages (homepage, blog,
about, etc...)

Other

MVA Mozton @areej_abuali
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We now need to figure out which
templates provide the most

IV Mozton @areej_abuali



Let's analyse some data




P What data do we need per template?

1. # of (and % from total)
2. #of (and % from total)
3. #of (and % from total)

Sessions & Leads date range — past 12 months

MVA Mozton @areej_abuali
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Template | Indexed | Organic | Organic

Pages | Sessions | Leads

CSP 35% 55% 75%
Other 10% 207 15%
CLP 10% 15% 9%
CHP 457 10% 1%

. q MozCon

Virtual
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Template

Indexed | Organic | Organic

Pages | Sessions | Leads

CSP 35% 55% 757
Other 10% 20% 15%
10% 15% 9%

Ea

. MozCon
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Wouldn't we be better off spreading our

across more
valuable pages?
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Wouldn't we be better off having Google
our more valuable pages”?

IV Mozton @areej_abuali



And most importantly:

Is it worth up our number
of indexed pages for only

of organic leads?

MV MozCon @areej_abuali
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Websites do not
(and most probably should not)

need to have
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Instead, focus on indexing pages that
have the potential to provide

MVA Mozton @areej_abuali



Yes, this feels like a fairly

...but every
aggregator site tends to have one of these
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There’s also so much more that can be
on a template by template basis

Template | Indexed | Organic | Organic
Pages | Sessions | Leads
CSP 35% 55% 75%

MV MozCon @areej_abuali
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» Our indexed filters

» Make » Transmission
» Model » Engine size
> Year » Colour

» Type » Price range
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» Our indexed filters

» Make » Transmission
» Model » Engine size
> Year » Colour

» Type » Price range
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That's potential indexed pages
purely based on our search result filters

MVA Mozton @areej_abuali



So it's fundamental that we break this
down to the next level

Template | Indexed | Organic | Organic
Pages | Sessions | Leads
CSP 35% 55% 75%

MV MozCon @areej_abuali
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Template | Indexed | Organic Organic
Pages Sessions Leads

CSP/Make

CSP/Model

CSP/Year
CSP/Type

Virtual @areej_abuali
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b The more we slice and dice our
data, the more we’ll be able to make

iInformed decisions.




*Intermission™




A in the life
of an SEO...

MVA Mozton @areej_abuali
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Let's say hello to a senior stakeholder
named

IV Mozton @areej_abuali



P Mark

“Car history information pages are
critical for our consumers. They can

look up

and get all the information
they need.”
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p SEO:

“Yes, but they are useless for Google.
They're that provide

and

JJ
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P Mark:

“Nevermind Google, what does this
mean for 77

MVA Mozton @areej_abuali
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p SEO:

“‘Well, I'm glad you asked because |
spent the past 2 weeks doing this piece
of analysis where | used BigQuery to
group our page templates, calculate our
organic leads per template, and.... ”

MVA Mozton @areej_abuali



P Mark:

(11 J)

N1 MozCon -
..... | @areej_abuali
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p SEO:

MM Mozeen

(14

of our total organic leads. ”

@areej_abuali
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P Mark:

“Is that it? De-index these pages

JJ

MVA Mozton @areej_abuali
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P Mark:

“Work with to build a strategy
that can convince to convince
to consider convincing to
potentially de-index the pages.”

MVA Mozton @areej_abuali



» SEO:

(11

J)

@areej_abuali
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Joking aside, | promise you there is a
to this story

IV Mozton @areej_abuali



b As SEOs, we need to speak the
SAME language as senior
stakeholders to get sign off on
technical fixes.




Let's Recommend




Template

Indexed | Organic | Organic

Pages | Sessions | Leads

CSP 35% 55% 757
Other 10% 20% 15%
10% 15% 9%

Ea

. MozCon

Virtual
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MozCon
Virtual

Template

Indexed
Pages

45%

Organic
Sessions

10%

Organic
Leads

1%

@areej_abuali
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10% of total organic sessions is
to simply get rid of...

M MozCon
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I'm very risk-averse but in this specific case:

IV Mozton @areej_abuali



Every aggregator/classified type website
tends to have something similar to a

MVA Mozton @areej_abuali



These pages are
because they want to look up info via

a car registration number
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So to be on the , let's do a few
checks on our car history pages (CHPs)
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» Do they take up lots of ?

, we analysed our logs and in an
average week,
are spent on CHPs.
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» Do they for important terms?

, we analysed our ranking data

and CHPs for any
keywords we care about.

MVA Mozton @areej_abuali
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» Do they have ?

, but it's , only useful for
users on a personalised basis
and doesn't convert.

MVA Mozton @areej_abuali



» Do they have high quality ?

, they barely have backlinks
pointing at them and none that

dle

MVA Mozton @areej_abuali
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p So, to summarise:

» 45% of total

» 50% of weekly

»  10% of total
content

» Minimal

» Minimal

MV MozCon @areej_abuali
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Now, do we feel
de-indexing them?

IV Mozton @areej_abuali



» Things to remember

Make sure your sitemaps are setup
to automatically remove any

MVA Mozton @areej_abuali



This is an example of something that might

seem but can be
more complex due to legacy code

MVA Mozton @areej_abuali



» Things to remember

Our CHPs won’t de-index ,

it could take a few months (or more) for
Google to flush them out of the index

MVA Mozton @areej_abuali
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» Things to remember

Blocking CHPs from
should be on the roadmap but give it

1-3 months to flush out of the index

MVA Mozton @areej_abuali
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Let's Prioritise




As an industry, let's make a pact to drop the

IV Mozton @areej_abuali



Prioritisation Is

@areej_abuali



| like to use
because it's simple

11380888

MV MozCon @areej_abuali
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» SEO Impact

How much of an will
this recommendation likely have on
our overall organic leads?

MVA Mozton @areej_abuali



» Tech Effort

How much will this
recommendation take to
implement?

MVA Mozton @areej_abuali
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» Tech Effort

MV Mozton @areej_abuali
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» Prioritisation Matrix

For every

SEO Impact [ — R

MV MozCon @areej_abuali
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PRIORITY RULE PRIORITY

If SEO Impact = L & Tech Effort =S High
If SEO Impact = L & Tech Effort =M High
If SEO Impact = M & Tech Effort =S High
If SEO Impact = L & Tech Effort = XL Mid
If SEO Impact = L & Tech Effort =L Mid
If SEO Impact = M & Tech Effort = M Mid
If SEO Impact =S & Tech Effort =S Mid
If SEO Impact = M & Tech Effort = XL Low
If SEO Impact = M & Tech Effort =L Low
If SEO Impact =S & Tech Effort = XL Low
If SEO Impact =S & Tech Effort =L Low
If SEO Impact =S & Tech Effort = M Low

MVA Mozton @areej_abuali
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If you want to learn
more about my full
framework:

bit.ly/aree|-matrix

Getting Tech SEO Implemented

Januar y 10, 2021

MV MozCon @areej_abuali
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Let’'s Communicate




S0, what's the that tends to
happen once an SEO recommendation

gets implemented?

MVA Mozton @areej_abuali



p Senior Stakeholder™:

"Are organic leads up yet?”

Yup, still Mark!

MozCon : :
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Yes, our senior stakeholder will be expecting
results, and they'll be expecting it
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» Manage expectations

» Communicate
» Communicate
» Communicate

MV MozCon @areej_abuali
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Under-

Over-

MozCon : :
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De-indexing CHPs is simply a

for fixing technical foundation

't won't magically increase our share of voice
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Communicating
IS one thing...

MozCon : :
M Moz @areej_abuali



Communicating updates that are backed
up with IS @ game changer
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Let's go back here...

Indexed Pages

Organic Leads

@areej_abuali



p Keep everyone informed

» Update these metrics on a
» Show WoW, MoM and YoY change
» Make our dashboards &

MVA Mozton @areej_abuali
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Stakeholders feel knowing
the information is there
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And It'll serve as a and
can be used as case studies for
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One Final Thought...




I've personally never worked on a car

aggregator website
This was just an example
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But this methodology can apply to all
forms of aggregator sites:

) )
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When | first pitched this talk, my aim was
to go into detall about the

for aggregator sites
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But the actual technical recommendation
Is the part...
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It's the backing up our recommendation
with data, the stakeholder management,
the meetings for the sake of meetings...
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The first time | worked on an
aggregator-type site,
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| felt completely OUT OF my depth
and | didn't know where or how to start



But they're now the type of websites that
| working on the most...
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Because over time, I've come to realise that
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And once we fix the problems that actually
matter, the impact feels very
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, rewarding in terms of

MVA Mozton @areej_abuali
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But also in terms of achieving higher level
of with stakeholders...
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Which makes the process

easler the next time round

) ¢ MozCon areej abuali
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The past were based on an
example that simply touched

metric
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| tied

(a technical SEO metric)

to
(the KPI that matters to the business)
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This same concept can be translated
across far more

MozCon . :
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As SEOs, it's fundamental that we
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We can achieve far more if we

using metrics that our business cares about
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And please
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p

It's okay to feel overwhelmed
working on something new =)




bit.ly/areej]-mozcon
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THANKS!

Ouestions?

You can find me on:
» areejabuali.com
» (@aree]_abuali

MV MozCon @areej_abuali
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https://www.areejabuali.com/

Thank You!
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